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About Mendelian Inheritance In Man (MIM)...
Mendelian Inheritance in Man (MIM) was created by:
Victor A. McKusick, M.D.
University Professor of Medical Genetics,
The Johns Hopkins University School of Medicine

Copyright (C) 1966-1997
The Johns Hopkins University Press
701 West 40th Street
Baltimore, MD 21211 USA

The original On-Line Mendelian Inheritance in Man (OMIM) was an IRX-based query interface to the 
text of MIM that could be accessed over the Internet with the Telnet utility or by modem dial-up. It was 
maintained by the staff of the Human Genome Data Base at The Johns Hopkins University. Currently the 
primary interface to OMIM is via the World Wide Web. The Web version of OMIM is supported by the 
National Center for Biotechnology Information (NCBI).

The CD-ROM version of MIM for Microsoft Windows was implemented by Ray Duncan, Dept. of 
Pediatrics, Cedars-Sinai Medical Center, 8700 Beverly Blvd., Los Angeles, CA 90048 
(duncan@csmc.edu). The data sources were the files omim.txt and genemap.txt dated May 2, 1997, 
and downloaded from the NCBI FTP server.

License and Warranty
The CD-ROM version of Mendelian Inheritance in Man is licensed for use on a single computer at a 
time. Mendelian Inheritance in Man on CD-ROM is published by Ray Duncan, MD, and distributed by 
The Johns Hopkins University Press.

The text of Mendelian Inheritance in Man is Copyright (C) 1997 by The Johns Hopkins University. 
Commercial use is prohibited without explicit written permission of the University. Images and video clips 
are the property of the donor, and should not be reused in any way without written permission from the 
donor.

The CD-ROM version    of MIM is distributed "as is" and without warranty of any kind. In particular, no 
warranty is expressed or implied concerning completeness or accuracy of content. Lay users, and 
professional users viewing genome data outside their area of expertise, are advised to seek the 
assistance of an expert in the interpretation of MIM entries. Cedars-Sinai Medical Center and The Johns 
Hopkins University Press are under no circumstances liable for consequential damages or related 
expenses, even if we have been advised in advance of the possibility of such damages.



MIM CD-ROM Technical Information
The CD-ROM version of MIM for Microsoft Windows was implemented with the aid of the following 
systems and tools:

Microsoft Multimedia Publishing Toolkit, version 2.0.
Microsoft Access, version 2.0.
Microsoft Windows, version 3.1.
Microsoft Windows NT, version 4.0.
Stirling Technologies InstallShield, version 2.0.

The text of On-Line Mendelian Inheritance in Man (OMIM) was transferred across the Internet from NCBI 
to a Dell 486/66 running Microsoft Windows/NT version 4.0 at CSMC. The text was translated to tagged 
Rich Text Format (RTF) and integrated with photographs using a custom program developed at CSMC. 
The RTF file was then compiled into a full-text-searchable Multimedia Viewer text database (OMIM.MVB),
using the Microsoft Multimedia Compiler version 2.0.

The MIM on-line manual was written in Microsoft Word for Windows version 6.0 and compiled with the 
Microsoft Help Compiler version 3.1 (HCP.EXE).

Photographs were digitized with the Hewlett Packard IIcx flatbed scanner or Polaroid SprintScan 35 slide 
scanner, then processed and cropped with Adobe Photoshop.

Screen shots were captured to the clipboard with the PrintScreen key, pasted into Microsoft BitEdit, 
cropped, and saved to disk as 16-color bitmaps for incorporation into the on-line manual.
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The MIM Button Bar provides a quick way of accessing the most commonly needed functions of the MIM
viewer. The Contents button displays the main, or contents, page of the MIM file. The Go Back button 
returns to the most recently viewed entry. The History button displays a chronological list of the recently 
viewed MIM entries. The Search button activates the control window for full-text searches. The Index 
button displays the keyword index window. The Picture button displays the photograph(s) associated with
the currently displayed MIM topic, if any. The Video button displays the video clip(s) associated with the 
currently displayed MIM topic, if any. The left and right arrow buttons are for browsing, and will display the
MIM entry with the next lower or next higher MIM number, respectively.









Introduction
This CD-ROM is a full-text-searchable, multi-media implementation of Victor McKusick's book Mendelian 
Inheritance in Man (MIM) and its Internet derivative On-Line Mendelian Inheritance in Man (OMIM). 
The text of MIM was obtained from the public FTP server at the National Center for Biotechnology 
Information (NCBI), integrated with photographs from the collection of medical genetics faculty at 
CSMC/UCLA and other institutions, and compiled into a file that can be viewed, searched, and printed 
with the Microsoft Multimedia Viewer. 

During installation, an icon entitled "MIM for Windows" is created in the Windows Program Manager group
MIM.    If you double-click the "MIM for Windows" icon, the MIM viewer is launched and you will see the 
MIM "contents" page:

You can return to the contents page at any time while you are using MIM by clicking the Contents button 
at the left end of the MIM button bar.

The MIM entry for a particular disorder can be reached by several paths. If you happen to know the "MIM 
number" for the disorder, you can click on the appropriate MIM number range on the contents page, 
which will bring you to a more detailed MIM number index.    For example, if you want to read about 
achondroplasia, and you know that the MIM number for that disorder is 100800, you can begin by clicking
the line

Autosomal Dominant Traits (MIM 1xxxxx)



on the MIM contents page. The index for the MIM 1xxxxx numbers will then appear:

You can scroll through the index if necessary, then click on the appropriate MIM number for the entry you 
are interested in. For example, if you click on the line that says:

100800    ACHONDROPLASIA
You will immediately see the MIM entry for achondroplasia:



(MIM for WIndows also has other indexes, selectable on the contents page, which provide access to 
hereditary disorders by the symbol, name, or location of the associated locus.)

Once you've displayed the MIM entry for achondroplasia, there are many things you can do with it. 

* You can read the entry directly on the screen, or you can print it out by selecting Print Topic on the 
File menu. 

* You can set a bookmark on the entry by picking Define on the Bookmark menu, in effect building 
your own private, customized index to MIM. 

* You can add your own comments to the entry by selecting Annotate on the Edit menu. 

* You can browse through related MIM entries by clicking the left and right arrow buttons on the MIM 
button bar. 

* You can copy part or all of the text of an MIM entry to the Windows clipboard by picking Copy on the 
Edit menu, then paste the text into another Windows program such as a word processor. (Note: if you
use MIM text in educational materials or a published work, you must obtain the advance approval of 
The Johns Hopkins University Press and include proper copyright acknowledgements.)

In the case of achondroplasia, there are one or more photographs associated with the text, so the Picture
button on the MIM button bar is active. Clicking on the Picture button will cause the picture(s) to be 
loaded and displayed in a separate scrollable, resizable window. (Note that all MIM pictures are scanned 
and sized for use on a 256-color display of 800x600 resolution or greater. They cannot be viewed on 16-



color displays, such as a standard IBM VGA display.)    A few topics include motion video clips instead of 
(or in addition to) pictures. These video sequences can be viewed by clicking the Video button.

What if you don't happen to know the MIM number for achondroplasia? You can still find the MIM entry for
achondroplasia, and in fact all MIM entries that mention achondroplasia at all, with the MIM viewer's full-
text search capability. First, click on the Search button on the MIM button bar, and the search window will 
be displayed:

The search window has its own on-line help, and you can click on the Options or Hints buttons to find 
out more about entry of search parameters and specialized search techniques. For now, just click the 
mouse in the text entry box and type the term "achondroplasia," make sure that the All Topics radio 
button is selected, then click the mouse on the OK button. You will soon see the search results window, 
containing a list of 31 topics that include the word "achondroplasia:"

The search results window is resizable, so you can grab the left or right border of the window with the 
mouse and stretch the window to make the search results list more readable. In this case, the first entry in
the search results list is obviously the primary entry for achondroplasia, so you can select it with the 
mouse and then click the Go To button to view the entry.

Another way to find information about a particular topic is to use the keyword index. Click the Index 
button on the MIM button bar to display the index window. You can either scroll through the list of 
keywords and select one directly with the mouse, or you can type a term into the window and the list will 
scroll automatically to the keyword that is the closest match. 



Either way, once you have located and selected a keyword, you can click the OK button to view the MIM 
topic associated with that keyword. If more than one MIM topic is associated with the keyword, a separate
topic list window will pop up (similar to the search results window). You will then need to pick one of the 
topics from the list and click the Go To button to view the entry.

When browsing through the MIM topics on a long search results list, it is often hard to remember where 
you've been. For this reason, the MIM viewer maintains an electronic trail of breadcrumbs called the 
"history list." You can click on the History button on the MIM button bar to view the history list at any time:

When you pick an entry on the history list and click the Go To button, the text of that topic will reappear 
immediately in the MIM viewer's main window. Like the search results window, the history list is resizable; 
you can grab the left or right border of the window with the mouse and stretch the window to make the list 
more readable.

You can exit from the MIM viewer at any time by picking Exit from the File Menu, by picking Close from 
the System Menu (at the left-hand end of the window's title bar), or by double-clicking the System Menu 
box.









Navigating in the MIM Viewer
Navigation Overview
There are many ways of navigating through MIM. You can select topics from the Contents screen, jump 
from one topic to another from a hot spot, browse through topics that are related to one another, retrace 
your steps backwards (topic by topic), or return to any previously viewed topic.



Navigating in the MIM Viewer
Using Links
MIM topics are linked to one another by means of hot spots. A hot spot can be a word or phrase, or a 
picture or part of a picture. Text hot spots may be underlined, and are usually displayed in a different color
than the surrounding text. A picture hot spot may have a border around it. You can identify a hot spot by 
noticing the mouse cursor: it changes to a pointing hand when over a hot spot.

In addition to jumping to other topics, hot spots can bring up popup windows. Popups are displayed over 
the main Viewer window. To remove the popup, click anywhere outside of the popup, or press the Esc 
key. Click on this hot spot to view a popup window.



Navigating in the MIM Viewer
Browsing Through Topic Sequences
Related topics may be linked to one another using browse sequences. The browse feature lets you 
browse through topics, one by one.

To display the next or previous topic:

* Choose the >> button or << button in the MIM Viewer window.

See Also
Using Links



Navigating in the MIM Viewer
Jumping to the Table of Contents
The Contents button, on the MIM Viewer button bar, returns you to the main screen for MIM. This screen 
is like a table of contents, from which you can select a variety of index topics.    Each index topic is a 
sorted list, from which you can jump to a specific MIM entry.

To look up a topic from the contents screen:

1 Choose the Contents button in the Viewer window to display the contents screen for MIM.

2 Select the name of the index topic you want to view from the list.

See Also
Browsing Through Topic Sequences



Navigating in the MIM Viewer
Returning to the Last Topic Viewed
Using the Go Back button, the MIM Viewer lets you retrace your steps. In this way, you can step 
backwards through the topics viewed.

To backtrack through topics in the order you viewed them:

* Choose the Go Back button in the Viewer window.

If the current topic is the first topic you viewed, the Go Back button appears dimmed.

See Also
Returning to Any Topic Viewed



Navigating in the MIM Viewer
Returning to Any Topic Viewed
As you view topics, the MIM Viewer keeps a record of where you have been. The History button displays 
a list of the topics you've viewed, starting with the most recent. Select any topic from this list to return to it.

To jump back to a topic using the History button:

1 Choose the History button in the Viewer window.

The MIM Viewer lists the last 40 topics you have viewed in the History window.

2 Double-click the topic you want to view.

Use the scroll bar to see topics not visible in the list.

3 The History window remains displayed. You can choose another topic. You can also resize or 
move the History window.

Tip: You may want to arrange the Viewer window and the History window so that they are side by side.

To close the History window:

* Choose Cancel, or double-click the Control menu box. Pressing the Esc key also closes the 
History window.

See Also
Returning to the Last Topic Viewed



Finding Information
Ways to Find Information In MIM
To find information in MIM, you can use the following techniques:

- Choose topics from a keyword index

- Perform full-text searches for topic text

Using the Index button, you can search on a keyword or words. When the keyword is found, the MIM 
Viewer displays the topic, or a list of topics containing the keyword.

Using the Search button, you can search on any word or words in the topics. The Search feature not only 
takes you to the topic found, but highlights the word or words found by the search. You can use search 
operators such as AND, OR, NOT, THRU, and NEAR to further narrow your search.

See Also
Finding Information Using the Index

Using Full-Text Search



Finding Information
Finding Information Using the Index
Using the Index is like using the index of a book. You can browse through a list of keywords, and then 
jump to a topic by selecting a word from the index.

To look up a topic using the index:

1 Choose the Index button in the Viewer window.

2 Type the word you want to search for or select the word from the Index list.

You can press a key on your keyboard to move quickly to different parts of the list. For example, 
type "S" to move to words beginning with the letter "S" and then type "O" to see words beginning 
with "So."

3 Choose OK.

If only one topic is linked to the word, Viewer jumps to that topic.

If there is more than one topic linked to the word, Viewer displays the topics in the Topics 
Indexed dialog box.

To return to the Index, choose the To Index button.

4 Double-click the topic you want to view, or select the topic and choose the Go To button.

See Also
Using Full-Text Search



Finding Information
Using Full-Text Search
To search for MIM topics that contain a certain word or phrase:

1 Choose the Search button in the MIM Viewer window.

2 In the Search by Word box, type a search query telling Viewer what text you are searching for.

To enter a search query that you've searched on previously, select the search query from the 
drop-down list box.

3 Under Search In, select All Topics, Current Topic Only, or List of Previous Topics Found.

To search only the topic titles, choose the Options button and select this option, then choose 
the OK button.

4 Choose OK.

Viewer lists the title of each topic containing a search hit in the Search Results dialog box.

See Also
Browsing Through the Search Results

Using Search Operators



Finding Information
Browsing Through the Search Results
When you choose the OK button to search for information, the MIM Viewer lists the topics that contain 
search hits in the Search Results dialog box.

To view a topic in the list:

* Double-click the title.

Use the scroll bar to see titles not visible in the list.

or
* Use the Search Results buttons to move through topics.

To view Do this
Selected topic Choose the Go To button or double-

click the topic.

Search dialog box Choose the To Search button.

Next search hit in the 
current topic

Choose the Next Match button.

Previous search hit in 
the current topic

Choose the Previous Match button.

When you view a topic with search hits, Viewer highlights the search hits in that topic. If you minimize the 
Search Results window, highlighting turns off until you maximize the Search Results window again.

To close the Search Results window:

* Choose the Cancel button in the Search Results window.

For your convenience, the Search Results window always appears on top of the MIM Viewer window. You
can resize it, move it, or you can minimize it to an icon and then restore it later when you need it.

See Also
Using Full-Text Search

Using Search Operators



Finding Information
Using Search Operators
When you use the Search button to search for information, you can use the search operators AND, OR, 
NOT, and NEAR to narrow your search. Each operator is described below. You can enter an operator in 
either lowercase or uppercase letters ("and" is interpreted the same as "AND").

AND
The AND operator selects topics containing all phrases connected by AND operators. If a phrase 
does not appear in quotes, any space between words in the phrase is assumed to represent an 
implicit AND. For example:

Bees love Honey

This phrase finds any topic containing the three words "Bees," "love," and "Honey." This is the 
same as specifying Bees AND love AND Honey. However, when quotes are used, Viewer 
searches for the entire phrase. For example:

"Bees love Honey"

This phrase finds any topic containing the phrase "Bees love Honey."

OR
The OR operator selects topics containing either phrase connected by OR operators. For 
example:

Bees OR Honey

This query displays topics containing either the word "Bees" or the word "Honey."

NOT
The NOT operator selects any topic that does contain the phrase preceding NOT, but doesn't 
contain the phrase following NOT. For example:

Bees NOT Honey

This query finds topics containing the word "Bees" but not the word "Honey."

NEAR
The NEAR operator selects any topic in which one phrase appears within a certain number of 
words of the second phrase. The default value is 8 words. For example:

Bees NEAR Honey

This query finds any topic in which the word "Bees" appears within 8 words before or after the 
word "Honey."

To change the default value, choose the Options button in the Search dialog box and enter a 
new number in the NEAR Means Within box. Words that are next to each other are within one 
word of each other.

Tip:    You can choose the Hints button in the Search dialog box for a quick reminder on how to use 
search operators.

See Also
Using Full-Text Search

Using Multiple Search Operators



Finding Information
Using Multiple Search Operators
When you use the Search button to search for information, you can use multiple search operators to 
define more complex search criteria. For example, if you enter honey AND bees NOT hives in the 
Search by Word box, Viewer will match topics that contain the words "honey" and "bees" but do not 
contain the word "hives."

By default, operators are evaluated from left to right. You can use parentheses to specify a different 
order--operators within parentheses are evaluated first.

This query Searches for
honey OR bees AND hives Topics containing either the word honey or the 

word bees in addition to the word hives.

honey OR (bees AND hives) Topics containing the word bees and the word 
hives or topics containing the word honey.

honey OR bees NOT hives Topics containing either the word honey or the 
word bees but not the word hives.

honey OR (bees NOT hives) Topics containing the word bees but not the word 
hives or topics containing the word honey.

Tip:    You can choose the Hints button in the Search dialog box for a quick reminder on how to use 
search operators.

See Also
Using Full-Text Search

Using Search Operators



Printing and Copying
Printing and Copying Information in MIM
You may want to use information from MIM in other applications, such as word processors. The MIM 
Viewer lets you copy text onto the Windows Clipboard. From the Clipboard, you can paste the text into 
any Windows application. You can also print out topics, and change printers from within Viewer.

See Also
Printing Topics

Copying Topic Text



Printing and Copying
Changing Printers and Printer Options
The MIM Viewer prints topics on the default printer. If you have installed more than one printer in 
Windows, you can make any of your installed printers the default printer. You can also change the default 
printer options.

To change printers:

1 From the File menu, choose Print Setup.

2 Select Specific Printer.

3 Select the printer that you want to change to, from the drop down list box.

If this file is not in the list box, switch to the Control Panel, select Printers, and activate the printer 
you want to use. Then switch back to Viewer.

4 Choose OK to close the Print Setup dialog box.

To change printer options:

1 From the File menu, choose Print Setup.

2 Choose the Options button to change the default printer options.

The options available depend on the type of printer you have selected.

3 Choose the options you want, and then choose OK.

4 Choose the OK button to close the Print Setup dialog box.

To change printer orientation, paper size, or source:

1 From the File menu, choose Print Setup.

2 Select Portrait or Landscape for the orientation.

3 Select the paper size you want from the drop down list box.

4 Select the paper source you want from the drop down list box.

5 Choose OK to close the Print Setup dialog box.

For more information on setting up printers, see the Microsoft Windows documentation.

See Also
Printing Topics



Printing and Copying
Printing Topics
To print an entire MIM topic:

1 Display the topic.

2 From the File menu, choose Print Topic.

To print part of an MIM topic:

1 Display the topic.

2 From the Edit menu, choose Copy.

3 In the Copy dialog box, select the text you want to print, and then choose the Copy button.

4 Paste the text into a word processing application.

5 Use the Print command on the application's File menu to print the text.

See Also
Copying Topic Text



Printing and Copying
Copying Topic Text
To copy MIM Viewer text to the Clipboard:

1 Display the topic that contains the text you want to copy.

2 From the Edit menu, choose Copy.

3 Select the text you want to copy in the Copy dialog box.

4 Choose the Copy button.

To paste the Clipboard contents into another document, use the Paste command from the application's 
Edit menu.

Remember that the contents of MIM is protected by copyright.    Do not incorporate text from MIM into a 
commercial product or published work without prior authorization from The Johns Hopkins University 
Press.



Bookmarks and Annotations
Annotating MIM
The Bookmark and Annotation features in the MIM Viewer allow you to save personalized information in 
association with MIM. A bookmark is simply that: a marker which "saves your place" in MIM. Like any 
book, you can have many bookmarks in MIM. When the bookmark is selected, the MIM Viewer takes you 
directly to that topic.

Annotations are simply notes or comments "paper clipped" to an MIM topic. It's the same as paper 
clipping a note to a page in a book. You can copy and paste text in annotations.

See Also
Using Bookmarks

Annotating an MIM Topic



Bookmarks and Annotations
Using Bookmarks
Just as you can place bookmarks in a printed book to mark specific references, you can place 
bookmarks at the MIM topics you view frequently. Once you have placed a bookmark at a topic, you can
quickly display that topic from the Bookmark menu.

To insert a bookmark:

1 Display the topic at which you want to place a bookmark.

2 From the Bookmark menu, choose Define.

3 Viewer proposes the topic title as the bookmark name. If you want to change the name, type a 
new name in the Bookmark Name box.

4 Choose OK.

The bookmark name appears on the Bookmark menu.

To remove a bookmark:

1 From the Bookmark menu, choose Define.

2 Select the bookmark you want to remove.

3 Choose Delete.

4 Choose OK.

See Also
Jumping to a Bookmark



Bookmarks and Annotations
Jumping to a Bookmark
After you've inserted bookmarks in MIM, you can go directly to them at any time.

To go to a marked topic:

* From the Bookmark menu, choose the topic you want to view.

Underlined numbers precede the first nine bookmark titles. You can press the corresponding 
number key or choose the bookmark title to go quickly to a marked topic.

If more than nine bookmarks have been defined, choose More from the Bookmark menu. Select a
bookmark, and then choose the Go To button.

See Also
Using Bookmarks



Bookmarks and Annotations
Annotating a Topic
You can attach your own comments to an MIM topic. When you annotate a topic, the MIM Viewer places 
a paper clip icon to the left of the topic heading. The paper clip icon reminds you that you have attached 
text to that particular topic.

To attach text to the current topic:

1 From the Edit menu, choose Annotate.

2 Type the text in the Annotation edit box.

If you make a mistake, press Backspace or the Delete key to erase any unwanted characters and
then continue typing.

3 Choose OK when you have finished the annotation.

To remove an annotation:

1 Display the topic where you made the annotation.

2 Click the paper clip icon.

3 Choose the Delete button.

See Also
Viewing an Annotation



Bookmarks and Annotations
Viewing an Annotation
To view an annotation:

1 Display the topic where you made the annotation.

2 Click the paper clip icon.

3 Choose the Save or Cancel button when you have finished reading the annotation.

Tip:    Place a bookmark at an annotation to return to it quickly.

See Also
Copying and Pasting Annotations

Using Bookmarks



Bookmarks and Annotations
Copying and Pasting Annotations
You can copy text from an annotation to the Clipboard or paste text from the Clipboard into an 
annotation.

To copy text from an annotation to the Clipboard:

1 Display the topic where you made the annotation.

2 Click the paper clip icon.

3 If you want to copy all of the annotation, choose the Copy button.

If you want to copy only a portion of the annotation, select the text in the Annotate edit box, and 
then choose the Copy button.

To paste text from the Clipboard into an annotation:

1 Display the topic where you made the annotation.

2 Click the paper clip icon.

3 Position the insertion point where you want to paste the text.

To position the insertion point, point and click the mouse or press the arrow keys.

4 Choose the Paste button.

If any text is selected when you choose the Paste button, it is replaced by the new text.

See Also
Copying MIM Topic Text



Buttons and Menus
File Menu Commands
The File menu contains these commands:

- Open

- Print Topic

- Print References

- Print Setup

- Exit

Scroll down to see descriptions of each command.

Open
Displays a dialog box in which you can select and open a Viewer title.

Print Topic
Prints the displayed topic (assuming you have a printer installed and turned on).

Print References
Prints the references associated with the displayed topic (assuming you have a printer installed 
and turned on).

Print Setup
Displays a dialog box in which you can change printer settings before printing.

Exit
Closes Viewer.

See Also
Changing Printers and Printer Options

Printing Topics



Buttons and Menus
Edit Menu Commands
The Edit menu contains these commands:

- Copy

- Annotate

Copy
Places a copy of the displayed topic in a dialog box, where you can select text to copy to the 
Clipboard.

Annotate
Displays a dialog box in which you can attach your own notes to the current topic.

See Also
Copying Topic Text

Annotating a Topic



Buttons and Menus
Bookmark Menu Commands
The Bookmark menu contains these commands:

- Define

- More

Scroll down to see descriptions of each command.

Define
Displays a dialog box in which you can add a bookmark to the current topic or delete an existing 
bookmark.

More
This command appears only when more than nine bookmarks have been added to the Bookmark 
menu. Displays a dialog box in which you can select a bookmark.

See Also
Using Bookmarks

Jumping to a Bookmark



Buttons and Menus
Help Menu Commands
The Help menu contains these commands:

- Help for    the MIM Viewer

- About Viewer

Scroll down to see descriptions of each command.

Help for the MIM Viewer
Displays this Help file.

About Viewer
Displays a dialog box which displays the Viewer version and copyright information.



Buttons and Menus
Using the Button Bar
The button bar, which is located immediately beneath the menu bar, helps you browse and look up 
information in the MIM Viewer.

The Contents button displays the contents screen for MIM.

The Index button displays the keyword index for MIM.    You can select a word from the index list, and 
then display a topic that contains information related to that word. For more information, see Finding 
Information Using the Index.

The Go Back button backtracks through topics in the order you viewed them.    For more information, see 
Returning to the Last Topic Viewed.

The History button displays a list of the last 40 Viewer topics you have viewed. Double-click any topic title
to redisplay the topic. For more information, see Returning to Any Topic Viewed.

The Search button allows you to search for any combination of words and phrases, and then browse the 
topics that contain search hits. For more information, see Using Full-Text Search.

The Picture button displays picture(s) for the current MIM topic, if any are available.    To display pictures, 
you need a video display with at least 800x600, 256-color resolution. If you attempt to display a picture in 
a 16-color (VGA) display mode, an error message will appear instead. Use Windows Setup to select a 
256-color display mode, then restart Windows.

The Video button displays video clip(s) for the current MIM topic, if any are available.    For best results, 
you need a video display with 256-color resolution.    Pictures can be displayed on a standard VGA display
(640x480, 16-color) but will be severely distorted.

The << button displays the previous topic.    Clicking the << button is like turning to the previous page in a 
printed book.

The >> button displays the next topic.    Clicking the >> button is like turning to the next page in a printed 
book.



Controlling Sound and Video
Using the Multimedia Controller
You can play an audio or video sequence using a control panel that appears within a topic or that pops 
up when you select a hot spot. Either type of sequence may include the multimedia controller.

To control a sequence that does not have a control panel:

* Click the window while the sequence is playing to stop it.

* Click the window after stopping the sequence to start playing it again.



Keyboard Techniques
Using Accelerator Keys
The following is a list of keyboard shortcuts available in Viewer:

Keys Action
Ctrl+C, Ctrl+Ins Copies the displayed topic to 

the clipboard

Ctrl+Shift+Alt+F1 Jumps to the Contents screen
Ctrl+Shift+Alt+F2 Brings up the Keywords dialog

Ctrl+Shift+Alt+F3 Takes you to the last topic 
viewed (Go Back)

Ctrl+Shift+Alt+F4 Brings up the History list

Ctrl+Shift+Alt+F5 Displays the previous topic in 
the browse sequence

Ctrl+Shift+Alt+F6 Displays the next topic in the 
browse sequence

Tab Moves to next hot spot
Shift+Tab Moves to previous hot spot

Ctrl+Tab Highlights all hot spots

Esc Removes the top-most popup

Alt Removes all popups



Contents button
The MIM Viewer button that displays the contents screen for MIM.



Keywords button
The MIM Viewer button that looks up topics associated with particular words or phrases defined by the 
author.



Go Back button
The MIM Viewer button that backtracks through topics in the order you viewed them.



History button
The MIM Viewer button that displays a list of the last 40 topics you have viewed.



>> button
The MIM Viewer button that displays the next topic in the current browse sequence within MIM.



<< button
The MIM Viewer button that displays the previous topic in the current browse sequence within MIM.



Search button
The MIM Viewer button that searches for all topics containing a particular word or combination of words.



Hints button
In the Search dialog box, the button that shows examples of how to enter search queries.



Next Match button
The button in a list of search hits that displays the next search hit not currently displayed on the MIM 
Viewer screen.



Previous Match button
The button in a list of search hits that displays the previous search hit not currently displayed on the MIM
Viewer screen.



To Index button
The button in the Topics Indexed dialog box that takes you back to the Keywords Index dialog box.



To Search button
The button in the Search Results dialog box that takes you back to the Search dialog box.



Options button
The button in the Search dialog box that displays the available search options. The Search Options dialog
box is where you can change the NEAR value, select topic titles as the search domain, or select to 
search from a list of previous topics found.



Go To button
The button in the Topics Indexed and the Search Results dialog box that displays the selected topic 
from the list.



bookmark
A name associated with a topic for easy reference. Bookmarks appear on the Bookmark menu. When 
you select a bookmark from the menu, the MIM Viewer immediately displays the topic associated with 
that bookmark.



Clipboard
The Microsoft Windows application that holds cut or copied information, which you can then insert into 
another file. Whenever you use a Cut, Copy, or Paste command, you are using the Clipboard.



contents screen
The "table of contents" for MIM. From this screen you can select which sorted index you want to look in.



topic
A single entry or article in MIM. Examples of topics might be a quotation, the definition of a word, or an 
article in an encylopedia.



Topics Indexed
An dialog box that lists topics from an keyword search which allows you to browse and go to topics in the
list.



Search Results
The dialog box that lists topics containing search hits from a search query and allows you to browse 
and go to topics in the list.



search query 
A combination of words, phrases, and operators telling the Search command what text to search for.



browse sequence
A sequence of topics arranged so that you view them in sequence when you select the << or >> buttons.



topic title
A name identifying a topic found by searches from the Keywords and Search commands.



jump
A hot spot that displays another topic in the main MIM Viewer window.



hot spot
A word, phrase, or picture that you select to jump to a new MIM Viewer topic, display a window, or 
perform an author-defined Viewer operation.



search hit
An occurrence of text in a topic that matches the search query entered for the Search command.



current position
The position in an audio or video sequence that is currently being played, indicated by the thumb in the 
slider control.



thumb
The pointer in the slider of a controller indicating the current position in the audio or video sequence.



slider
The control in an audio or video sequence that contains the thumb, which indicates the current position 
in the audio or video sequence. The slider may also include tick marks indicating the sections in the 
audio or video segment.



section
A subdivision of an audio or video sequence indicated by tick marks on the slider. Drag the thumb on the
slider to any tick mark to begin playing the sequence at the corresponding section.



Play/Pause Button
Plays the object if it is currently stopped or paused, or pauses the object if it is currently playing.



Stop Button
Stops playback of the audio or video sequence.



The slider control lets you drag the thumb to move the current position back (left) or forward (right) in 
the audio or video sequence.



Play Button
Starts playing the object.



Pause Button
Stops playing the object until the user presses this button again or the Play button.



Eject Button
Ejects the physical object from the MCI device (for example, the CD-ROM from a CD-ROM drive).



Previous Section Button
Moves playback backward to the previous section authored for the object.



Next Section Button
Moves playback forward to the next section authored for the object.



Step Backward/Fast Rewind Button
When clicked once, steps backwards (by frames or by seconds) in the object. When clicked and held 
down, rewinds backwards through the object.



Step Forward/Fast Forward Button
When clicked once, steps forwards (by frames or by seconds) in the object. When clicked and held down, 
fast forwards through the object.



Menu Button
A popup menu which lists the sections, if authored. Select a section name to move the thumb to the 
beginning of that section. This menu may also contain a mute or a pause option.



Pauses
When this option is selected, Viewer will pause before playing each section.



Mute
When this option is selected, the controller does not play any soundtrack while it plays the AVI sequence. 
In audio files, the sound is muted.






